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cartographic techniques 

SOITW ARE REVIEW 
Sottware l"l!\'le''°" h ill normallv b.! sohciltod 
bv the editors, but unsohoteci reV1ews are 
11l\'1tt?d for con~1derabon If you are usmi; 
a piece of sottware useful m working with 
map mformat1on, and are intere-;ted m con· 
tr ibuting a review, please communicate th1" 
interest to the editors. 

TWO MAPPING SOFrW ARE 
PACKAGES FOR MACJNTOSH 
COMPUTERS 
Reviewed by Gene Turner, Cnlifomin 
State University nt Northridge 

MacCltoro Tl with Map Animation. 
Image Mapping Systems, 516 S. 51 
Street, Omaha, l\"E 68106. 

Lis t $295. 

Atlas•MapMnker 4.53. 
Strategic Mapping, -1030 Moorpark 
Ave., San Jose, CA 95117. 

List $495. 

Anyone interested in looking al 
the distribution of data collected 
by statistical units such as coun­
ties, tracts, zip codes, or police 
reporting districts is likely to resort 
to the creation of a choropleth 
map. Its creation is straightfor­
ward and, once lhe boundaries for 
the s tatistical units are set, new 
maps are generated by changing 
the shading patterns according to 
the classes derived for new data 
variables. The process can be 
readily adapted to a computer and 
over the years a number of pro­
grams have been developed to 
generate choropleth maps. 

Macintosh computer users 
basically have two statistical 
mapping p rograms from which to 
choose. One, MacChoro ll, is a 
relatively simple choropleth 
mapping program with the 
capability of limited animation, 
while the other, MnpMaker 4.53, is 
more complex with many more 
options. Both take considerable 
memory (lMb minimum) and 

have slightly different approaches 
and features for creating a 
choroplcth map. For this review 1 
tried both programs on a Macin­
tosh Ila with color monitor, 8 Mb 
random access memory, 80 Mb 
hard db.k, and Virtual 2.04 from 
Connetix Corp. which increased 
available memory to about 12 Mb. 
This may seem like a lot of power 
to run a mapping program, but for 
application~ such as generating a 
map of the United States by 
county, it's not enough. Indeed 
files of such maps can grow to 4 or 
5 Mb in size after conversion to a 
PostScript format in one of the 
drawing programs. Dealing with 
very large map files almost be­
comes an art since they tax your 
hardware, your software, and your 
patience. 

MacCl1oro II 
MacC11oro II comes with a single 
disk containing the program and 
some sample maps of the "lower 
48" states. A 114 page manual 
introduces the program step by 
step. reviews each of the eight 
major menu headings, and pro­
vides several appendices for 
separate topics such as using 
MncChoro with other programs. A 
second disk containing county 
boundaries for each state may be 
purchased separately. 

Loading the program simply 
involves copying the files to the 
hard rusk. The creation of a map 
may begin by selecting an existing 
map file such as "US48.Data" 
which was provided w ith the 
program. After starting, two 
windows appear along with eight 
menu items - File, Edit, Window, 
Data, Animate, Map, Legend, and 
Text- across the top of the screen. 
One w indow contains a spread­
sheet which can hold up to 50 
variables for up to 600 areas. 
Users who want a tract map of a 
Metropolitan Statistical Area 
(MSA) or a county map of the 
United States (almost 3150 coun­
ties) will find the 600 area limit too 

few. The other window contain:. 
an outline map. To cause a 
choropleth map to appear one 
must select a desired data column 
from the spreadsheet and then 
click on the Draw Map button in 
the upper left part of the spread­
sheet. In addition, two other 
windows can be opened, a reduced 
view window of the entire graphic 
display and a window for text 
editing. Any of these may be 
brought forward by selecting one 
from the Window menu. 

The classification of the data for 
the map is controlled by the Data 
menu and the Classification 
option. Two to sixteen classes may 
be selected and six different 
methods are available. The 
"Unclassed" method defaults to 
the maximum sixteen classes. 
Other methods include a standard 
deviation and a natural-breaks 
method as well as the usual equal 
interval, quantile, and user­
defined methods. Under the 
Classification option is a Classifica­
tion Stats suboption which gives 
various descriptive statistics about 
the distribution of data within the 
classing method. In addition, a 
classification accuracy index gives 
a relative indication of how well 
the data fit d ifferent classing 
methods. 

Data (no values greater than or 
equal to one biJlion) may be 
brought into the program in 
several ways. It may be converted 
from an earlier version of 
MncChoro using the Read Old Data 
option under the File menu, it can 
be typed into the spreadsheet from 
the keyboard, and it can be pasted 
into the spreadsheet from any tab­
delimited spreadsheet. However, 
the user must be careful when 
entering data to ensure that the 
order of the data values exactly 
matches the order of the polygon 
boundaries. The program does not 
check a data ID against a polygon 
ID to match data to areas. This 
places an extra burden on the user 
to always check the order of data 
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since unexpected changes may 
occur. For example, census tract 
lists from different sources often 
have frequent mismatches. 

Names or other character data 
are converted to O's when im­
ported into the MncC/wro 11 spread­
sheet. Data can be exported from 
the spreadsheet in MncC/ioro 11 to 
another spreadsheet such as Excel 
by the same copy and paste 
procedure. Limited data handling 
options are available for the 
spreadsheet under the Ddta menu. 
Two columns may be added, 
subtracted, multiplied, or divided. 
Data also may be multiplied by a 
constant, converted to log form, 
and listed in sorted order. 

Some other data handling 
options in the program such as 
Search For and Tabs-to-Spaces 
under the Edit menu will only 
work with certain windows such 
as the Edit wrndow. Which 
commands are for which window 
is not always made clear by the 
program or the instruction 
manual. 

A second major set of informa­
tion for a statistical mapping 
program is the description of the 
geographical units to which the 
data values must be matched. 
Mac01oro II does not provide any 
routines for directly creating 
boundaries, but it does provide 
connections to other programs so 
that boundaries can be created and 
assigned identifying codes. 
Polygons can be imported from an 
earlier version of MacChoro IT, from 
MapMaker, from a scanned image 
input into a drawing program such 
as MacDraw or S11pcrPaint, and 
from a custom file of counties for 
all US states. A series of conver­
sion routines are buried in a 
submenu, Convert, under the 
submenu, Map File, under the 
main menu, File. Boundary files 
may also be exported to drawing 
programs via these options, 
modified, and then re-imported 
into MacChoro 11. lf ID's for the 
polygons are being entered into an 

imported map through the Edit-JD 
option, care is needed since it is 
not possible to undo an error. One 
must start over. 

MacOwro 11 provides several 
graphic utilities to enhance the 
map. Probably one of the most 
useful is the ability to generate a 
bar scale in miles or kilometers 
and drag it to a desired position. 
One may create a box of the 
desired length and then choose 
Scale from the Legend menu. A 
bar scale of a convenient length 
will be fitted in the drawn box. 
Other options include the capabil­
ity of computing the map scale, 
changing the choropleth shading 
patterns (from a fixed set of 24 
patterns) placing a frame line, and 
placing several pieces of text (title, 
date, source, classing method, and 
the accuracy index value). These 
items may be drawn in different 
colors although the actual map can 
only be displayed in one color in 
order to save memory. A legend 
may be easily created by creating a 
box and then selecting the legend 
option under the Legend menu. 
Minor adjustments to the type size 
and legend boxes can be per­
formed under the same menu. 
There is no zoom command on the 
map. 01anges in sue can be made 
in several somewhat av.'kward 
ways by erasing the map, clicking 
and dragging a map box, and then 
selecting Display in Frame from 
the File menu. The look of the 
map may be improved by drawing 
it over several pages and then 
specifying a reduction of 25 
percent in the Page Setup option 
under the File menu. This action 
results in finer, sharper lines on a 
LaserWriter printer. 

A special feature of MacChoro JI 
is its animation capability. Essen­
tiaUy this entails the generation of 
a sequence of maps and then 
flipping through them rather than 
making the map move around the 
screen. Two basic approaches can 
be taken. One is to generate a 
series of map classes for a single 

variable noting how the patterns 
change with the type of classifica­
tion or the number of classes. The 
second is to select a given number 
of classes of one type for a set of 
different vanables. Setting up an 
animation sequence 1s farrly easy 
and the process does give an 
interestmg look at multiple 
variables. One can make changes 
to the speed of animation or pause 
by clicking anywhere on the screen 
to call up a pop-up menu. A 
Copy-mode option appears to 
affect the way different patterns 
appear when plotted over one 
another, but there is no explana­
tion of this function in the manual. 
One can generate up to 255 maps 
for an animated sequence, but a 
300 by 400 pixel display requires 
about 15Kb per map. 

MapMaker 4.53 
This program provides a number 
of features (with the obvious 
exception of animation) beyond 
those of MacCltoro 11. In addition 
to choropleth maps, one also may 
create graduated symbol, dot, and 
value-by-area cartogram map 
forms and these may be displayed 
simultaneously. The program 
provides a number of ways of 
importing and exporting data and 
graphics to other programs (such 
as MacChoro ID and can provide 
the basic maps for generation of 
high-quality color printing. It can 
generate a map of all counties in 
the United States although one 
must have sufficient computing 
power and memory to attempt 
this. Enough features are available 
in MnpMaker 4.53 that it almost can 
serve as a stand-alone mapping 
program Wlth considerable design 
capability. 

MapMaker 4.53 comes on four 
disks. One contains the program 
and the three others contain 
outlines and some data for 150 
world countries, aJJ SO states, and 
all counties for all states. A large 
number of other geographical files 
such as census tracts, zip codes, 
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and major roads in the US may be 
purdtased from Strategic Map­
ping. After copying the program 
to a hard disk and s ta rting it, a 
blank window appears with eight 
items across the top menu: File, 
Edit, Assign. Layers, Categories, 
Displa) . Fonts. and Style. Generat­
ing the first map requires read ing 
the manual since the process is not 
intuitive. By selecting New under 
the File menu a sequence of 
windows begms which requests 
the number of boundary files to be 
assembled (usually each state is a 
separate file), the size of the map 
on the page, and whether any 
other geographic features are to be 
added. This step is important 
s ince the map can not be moved 
(unlike MncCiwro Jl) on the page 
after the user establishes a windo" 
for it. A map of the selected area 
will then appear within the user­
defincd window. 

The next step is to select the 
Import Data option under the File 
menu. Data is expected in the 
form of a tab-delimited text file 
with a maximum of 30 variables. 
Usua lly the first record in the file is 
a tab-delimited list of category 
headings. MapMnker will then 
read the data file matching an ID 
number in the fi rst field of the data 
file to a correspond ing number in 
the geographical boundaries. 
These h'\'O numbers must match 
exactly or the data will not be 
linked to the geographical units. 
Usually geographical units such as 
counties or census tracts are 
identified by some standard code 
such as FIPS codes since such 
values arc commonly part of large 
census fil es extracted from tapes. 
An advantage of this linking 
method is that the data file can be 
of any s ize or order and it does no t 
have to be processed to create a 
map of fewer areas. Once all data 
values have been read a map of the 
first variable is displayed . The 
actual data values for each geo­
graphical unit may be checked by 
selecting the Data Values option 

under the Assign menu. A lis t of 
areas then appears and one may be 
chosen for the d isplay of its values. 
Checking data values by moving 
through the list o f geographical 
units is rather s low compared to 
the spreadsheet display of 
MncChoro I/ Data can be exported 
m the form of a text file to other 
programs by selecting the Export 
Data option under the File menu. 

Jf a choropleth map is being 
produced, one of the first cosmetic 
changes to the map is to remove a 
set of point symbols from the 
legend which are assigned to each 
class along with a shading pattern. 
These are removed by selecting the 
Select Point Types option under 
the Display menu. Selecting the 
No Points Displayed on Map or 
Legend option remO\·es this 
feature from the legend . 

The data classification options 
available in MapMaker 4.53 are 
fewer than inMacCltoro II. Only 
equal interval, quantile, and user­
specified classification methods 
are offered. These are changed 
by selecting the Data Divisions 
option under the Assign menu. 
Also available under this menu 
is View Data Statistics which gives 
a descnphve lis t of the data 
distnbution. 

Unlike MacChoro II, the d efault 
shading patterns in MapMnker are 
not very suitable for a map smce 
they are coarse and possess little 
value difference. These can be 
changed with the Area Fill Pat­
terns option under the Assign 
menu. Any of 35 patterns can be 
selected although only a few 
possess suitable. non-textured 
value differences. Each may be 
specified in one of 8 colors against 
a background in one of 8 colors. 

Complebon of this s tep usuaUy 
results in a suitable choropleth 
map. Maps of other variables may 
be generated by selecting the 
desired one from under the 
Category menu . lf manual classifi­
cation has been selected, then new 
classes will have to be specified. 

Geographical data can be 
processed in a number of wavs m 
MapMaker. It can be converted 
from latitude and longitude to a 
map in one of six projections, 11 can 
be i.canncd and converted to a 
PICT file and then assigned ID 
numbers, or 1t can be d1giti.ced on 
the screen. Since the necessar) 
format is pr0\·1ded in an appendix 
of the manual, 1t 1s possible to 
write program& to reformat data 
from other programs to a form 
compatible \.vith MapMnka 

Boundary data is used for the 
d ot, choropleth, and cartogram 
displays. To change between the 
choropleth, dot. and cartogram 
map forms one need only select 
the Select Area Types option under 
the Display menu. A window 
appears with buttons to change the 
map form as well as spaces to set 
the dot value and unit area for the 
ca rtogram. Graduated symbols. 
however, require a special point 
file. Each point is located by a 
single x,y coordinate with an 
appropriate identifier. Features 
controlling this map form are 
found under the Select Point Types 
option under the Display menu. 

MapMakl!r provides a number 
of graphic utilities for enhancing 
the display. Along the left marg in 
arc a series of line and object 
drawing and shading tools com­
mon to many d rawing programs. 
Under the Assign menu are 
options to change the color of parts 
of the map and the legend as well 
as the background. These options 
enable one to easily generate 
colorful displays which are 
suitable for photography directly 
from the screen. Under the Assign 
menu are options to add a shadow 
around the edge of the map and to 
draw a grid of latitude and long1-
tude over the d isplay. Text of a 
desired font can be placed any­
where on the display. Titles. 
labels, and notes can be generated 
and dragged to a desired pos1hon. 
If the background is cluttered 
the type can be framed with a 



20 cartograpltic 11erspectivt'S Numbl'r 10. Summl'r 1991 

masking rectangle. 
A Layers menu provides other 

mteresbng possibilities. One 
option, Layer Options, makes it 
possible to copy different dISplavs 
to separate layers for manipulation 
and display. Several maps can be 
presented at once and selective!~ 
edited. The other option, Base 
Map Options. enables ont> to tum 
off the base map or the map 
distribution. By turning these off 
selectively, one can san~ a base 
map as a PICT file and separate 
dot patterns or polygon shading as 
additional files. These can be 
imported and recombined in a 
drawing program. For example, 
individual dot patterns might be 
created this way and then com­
bined into a single map ma 
drawing program. The L<1yer 
Option did seem to present some 
problems \\ith large files and 
would occasionally cause the 
program to crash although smaller 
files did not present a problem. 

Perhaps one of the s trongest 
cri ticisms of MapMaker is the lack 
of a good legend for the graduated 
symbol and cartogram map forms. 
Currently no reference syrnbols 
comparable to the map are dis­
played in the legend and this 
should be corrected. 

Both MncChoro II and MnpMaker 
4.53 perform acceptably well. 
Mnc010ro generates a more 
appropriate default map than 
MnpMaker and has some useful 
options such as bar scale genera­
tion, animation, and classification 
methods not available in 
MnpMaker 4.53. Mac01oro ll, 
however, generates only 
choropleth maps and does not 
seem to function in quite the same 
way as many Macintosh programs 
do. Often several steps are neces­
sary to perform a function that 
should be possible with a smgle 
command. For example, the 
importing and exporting o f data 
require several steps. The limita­
tion of 600 polygons m MncCltoro 
and lack of a color display tend lo 

make it less desirable for maps of 
entire MSA's or all counties of the 
United States. Ccrtainlv one 

; 

disadvantage of MncC/u>ro 11 is that 
the US Countv outlines must be 
purchased as a sepa rate file while 
the same file is mduded in the 
price of M1111Mnk1•r. 

MAPPING THEY ANOMAMO 
Anthropologist '\;apoleon 
Chagnon and the Stone-age 
Yanomamo - The nati\'e people 
of the Amazon River Basin - have 
a new way of defining home. 
Chagnon and Venezuelan anthro­
pologist Charles Brewer-Canas are 
using global positioning system 
technology to map the locations. of 
native ,·illages in the S1apa River 
Valley. 

In the first stage of a 10-year 
research project, Chagnon recently 
located eight villages, made 
contact "ith three previously 
undiscovered villages. and re­
corded more than 250 position 
fixes. A Trimble TransPak receiver 
(Trimble Navigation, Sunnyvale. 
California) was used to help 
navigate the unexplored regions of 
the basin. 

An estimated 14.000 tribes­
people live on Lhe Venezuelan 
side of the Amazon Basin; 9,000 
live on the Brazilian side. Al­
though mistreatment of the 
Yanomamo continues on the 
Brazilian side, the success of this 
survey may offer protection for 
the Venezuelan peoples. The 
president of Vcne1uela, Carlo~ 
Perez, has pledged to protect the 
Yanomamo from the encroach­
ment of modem civilization by 
creating a Siapa Valley Biosphere 
reserve. 
Geo Info S_vsle111s. /1111c 7 991 

LANDSAT NEWS 
Landsats 4 and 5 continue to 
function nominally. Landsat 6 
is on schedule for launch in 
mid-1992. 

Rep. George Brown (D-CA> 
introduced the Landsat Continuity 
Act on May 23. The goal of the 
legislation 1s to secure go,·ernment 
tunds to begin de\'elopment of 
Landsat 7 through the authori7cl· 
tion of $20 million for long-lead 
satellite hardware items. Brown 
said he fe lt the Landsat 7 tunding 
question had been delayed too 
long, putting the continuitv of the 
program m Jeopardy. Landsat 6 
will be due for replacement m 
1997, givmg contractors barelv 
enough time to develop Landsal 7 
even if funds are appropriated in 
the Fiscal Year 1992 budget 

The first round of hearing~ 
relating to the Landsat Continuity 
Act\\ ere held on Tune 26 at a jomt 
meeting of the Science, Space and 
Technologv Committee and the 
Permanent Select Committee on 
Intelligence. The Committee heard 
testimony from eight members of 
the remote sensing commumt~, 
representing three areas of data 
applications: military, scientific/ 
global change and civilian/ 
commercial. 
umdsat World Update 4:5. /1111t• 1991 

SPOT NEWS 
Sales of SPOT imagemaps are 
rising rapidly: 150 in 1989, 'iOO in 
1990, and a target figure of 1,000 
in 1991. A SPOT imagemap 
resembles a map, e:xccpt that tht• 
conventional planimetric content 1s 

replaced by a satellite image. If 
suitable ground control points arc 
available for level 2B prcproceS!'· 
ing, the absolute location accuracy 
is 30m. 

ln late 1990, SPOT L\itAGE 
decided to launch a nev.• family of 
products under the general 
tradename GEOSPOT. Physically, 
a GEOSPOT product is a map-typl' 
document on a SPOT satellite 
image undcrla\ It is geo-refer­
enced to a given cartographic 
projection, geo-coded to a specific 
geograpluc grid. and cut to match 
a specified system of map sheet 
lines or a geowaphic grid. Thcv 
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arc available in a range of scales 
from 1:25,000to1:100,000. Other 
scales between 1:10,000 and 
1 :250,000 are available on request. 
SPOT Flash 1, February 1991 

DIRECTORY OF COMPUTER 
AND HIGH TECHNOLOGY 
G RAl\ITS 
TI1e Directory of Computer n11d High 
Technology Grants lists 640 funding 
sources for computers, software 
and high-tech related grants. The 
Directory provides profiles on 
foundations, corporations and 
federal programs. 

Three essays on grantsmanship 
will guide you through the intri­
cate process of securing a grant. 
Gelling Grants a•ith Computers/ 
Ci!tti11g Computers with Grants 
makes suggestions on where to 
look for funding for computers. 
Another essay provides an 
enlightening debate between 
Apple and IBM computer experts. 
The third essay lists methods 
available to secure discounted and 
free software. 

The cost of the First Edition is 
$44.50 per copy (add $4.00 for 
handling). The Directory of Com­
puta and Hi~li Technology Grants 
can be ordered from the publisher, 
Research Grants Guides, Dept. 4B, 
P.O. Box 1214, Loxahatchee, FL 
33470. 

cart lab 
bulletin board 

Thb forum is,mert.'CI to encourngccommuna­
c.:ih(m amon~ pracutioner:s at i1 tame of rapid 
i.,._hnn lo,.;1c,1I tr.:111~111on. Qu<.':>m>n-., , om 
menb. and .mnuuncements are uwated. 

A New HyperCard S tack for 
Digital Cartography 
/eremy Crampton 
Pe1111 State 

The Temple University Cartogra­
phy Lab has developed a handy 
new Hvpct<...ud stack for Apple 
Macintosh computers for <.>di ting 

text on digital maps and other 
graphics that involve textual 
elements. The stack, called 
Text maker, allows users to create 
a separate document containing 
their text and then to import it 
into Adobe Lllristrafor 3.0. From 
there it can be converted into 
other formats, such as Aldus 
FreeHa11d 3.0. 

.. -'""''" ....... ··-..... ·­,,...,., ..,,... .r..,. ... s -....... , ..... ... ..,. 
:':~ ..... 
""'" ,_,_ ,.,, 
.a-tt•-ap 

Fi1111rt 1 

Textmaker (see Figure 1) was 
developed primarily for position­
ing place names, rather than blocks 
of text. The user types the list of 
names into a word processing 
document and imports it into 
Textmaker. A HyperCard button 
can then be used to save it in a 
form that J/111sfrntor can open. 

As digital cartography continues 
to replace manual production at 
cartography labs, cartographers 
are finding that in some applica­
tions it is often still useful to think 
of the digital mapmaking process 
in terms of traditional cartography. 
N'amc placement is one of thos~ 
areas. In manual traditional 
cartography it is common to 
produce an alphabetically ordered 
p roofing sheet of place names and 
other map labels that Clfford easy 
ecUting and revision. These labels 
are then individualh· removed 
and placed on the n~.1p. rextmnker 
was developed to emulate this 
process. 

I played with Tt'xtmnker in our 
lab using a Mac II. Although the 
HyperCard stack itself is fairly 
easy to use, experience with, or at 
least knowledge ot. the HyperCard 
environment would be a bonus. 

Once in Textmaker there is little 
need or scope for text formatting, 
this being best done in 11/ustrator 
(do your editing in the word 
processing program). There is a 
button labeled "change font" but it 
did not seem to do anything. 
Textmaker will be most useful to 
cartographers if they think of it as 
a conversion program rather than 
an editor or formatting environ­
ment. However, a useful addition 
for the future would be some kind 
of alphabetizing scheme, so tha t 
the list of names could be ordered 
for export to lllustratar. 

l began by typing lists of place 
names in several word processing 
packages, such as WriteNaw, 
WordPerfect and W(lrd. fn order to 
lest whether Tatmaka could retain 
formatting done at this stage, l 
varied the fonts and typesize of the 
names. However, since Textmaker 
can only accept ASCII format (such 
as the "text only'' option in 
WriteNow, or the "text only with 
line breaks" option in Ward, these 
forma ts were nullified, with the 
text coming into (and going out 
of) Ti•xtmnker only as Helvetica 
10 point. Since the flow of opera­
tions goes from a word processing 
pro~ram through Textmnker into 
lllustrator, it is best to do your 
editing before you import the 
text into Textmaker. And if. as 
expected, you are using Textmakcr 
for place names, a spell-checker 
will not be of much utility- old 
fashioned copy editing will be 
needed. 

To import the text into Textmaker 
I used Sigma Edi/, a utility that can 
be accessed under the Apple 
menu. {If you have System 6.xx, 
you can install a DA using the 
Font/ DA Mover; 1f you use 
System 7, just place the Sigma &f 1f 

application in the Apple "1enu 
items folder in the system folder.) 
To bring the text in, open 
Ti:xtmakt!r and then open Sigma 
Edit, which will allow you to open 
vour word processed file. Choose 
your text with the cursor or with 


